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H.S.H. FINAL GRAPHICS: The artist Package

An Artist Tool for MSX2Z computers.

INTRODUCTION

The Artist Package contains three powerfull drawing programs:
FINAL GRAPHICS
ICON PAINT SC5S
ICON PAINT SC8

FINAL GRAPHICS being the main program and the most advanced of
them all.

FINAL GRAPHICS provides a bit maped graphic mode screen of
512x212 dots, with 16 colours from a palette of 512 (BASIC's
screen 7). Best suited for very high quality drawings.

[CON PAINT SC5 provides a bit maped graphic mode screen of
256x212 dots, with 16 colours from a palette of 512 (BASIC's
screen 5). Best suited for games screens.

ICON FAINT SC8 provides a bit maped graphic mode screen of
256x212 with 256 colours on the screen at the same time (BASIC's
screen 8). Best suited for digitised pictures and very colourful
drawings.

These programs help you create art that suits your needs.
Whether you are creating flow charts or freehand illustrations,
you will find just the tools you need on any of the programs.
All of them include special commands such as Zoom, Copy,
Enlarge, Reduce, to make it easy to enhance your work. You can
even transfer and merge different pictures for easy alteration
and enhancement.

You needn't memorize complex commands or instructions. With
H.S.H.'s FINAL GRAPHICS you can create art as quickly as you can
point with a mouse or press a key.

This guide shows you how to get started with FINAL GRAPHICS or
ICON PAINT and provides a quick reference guide to the programs
tools, colours and commands. Once you understand these basics,
you’ll be able to experiment on your own.

The package contains some very high quality, drawn,
demonstration pictures. These are on the programme disk in
compressed form.



FINAL GRAPHICS V1.0

This 1is a full-featured drawing program, with pull down

and it allows you to create detailed multicolour pictures using
@ mouse connected to the joystick port A.

SOME DEFINITIONS

program,

¥ The 'menu bar’ contains the names of Final Graphics command

menus,

X The 'pointer' 1is the indicator you use to select
commands, tools and colours. The pointer changes colour
whenever you pick Up & new colour. The pointer will get both
colours: the foreground and the background colour.

nmenus,

¥ The term 'drag' means to press the left mouse button while
moving the mouse.

X The term 'click’ means to move the pointer onto an

icon or
menu and to press the left mouse button.

¥ The term ’'mark’ means to click the 1left button at the
upper/left corner and drag the mouse to the right and down

until the whole area to be marked is inside the box. Don't
forget to release the button.

MAKING A VORK DISK

If you are using a two-drive system, make a work disk for your
Final Graphics rogram before beginning your drawing session. You
will be able to store several art pictures on this work disk,

far more than you could on a disk containing other files.
create a work disk proceed as follows:

-

(1] Turn on the computer

[2] Put a blank disk in drive B and format it with the co
_FORMAT.

1 -

(3] Put the original Final Graphics disk in drive A and run

SET-UP program, by selecting SET-UP from the main menu
follow the instructions.

It is better to make a work disk for each of +the

three
programs.

If you are using a single-drive system follow the
instructions but swap the disks as required.

—

+
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STARTING FINAL GRAPHICS V1.0

(1] Turn on your computer and drive.
(2] Insert your work disc in drive A.

(3] Reset the computer. The program loads and runs auto-
matically.

[4] If your computer is provided with the manufacturer's built-
in software, then terminate that software first, and from
BASIC type RUN"AUTOEXEC. BAS".

SELECTING A TOOL AND USING THE MOUSE

To modify or to create your artwork, pick up a drawing tool from
the Tools menu at the top of the screen, and use it on vyour
picture by dragging the mouse, that is click the 1left button
while moving the mouse.

=11} If the menu bar isn’t on the screen then press the right
mouse button.

[2] Move the pointer onto the Tools title and click the mouse
button.

(3] The Tools menu will be displayed.

[4] Move the pointer onto a drawing tool, and click the item
currently highlighted.

(5] Drag the pointer to draw using the chosen tool. This method
will be used on all the programs.

SPARE and UNDO: F2 and Fl1l keys.

There are two commands that are accessed through the keyboard,

the UNDO and the SPARE commands. The video RAM of the MSX2
computers allows us to have from 2 to 4 full graphic screens in

memory. In Final Graphics only two screens are used, one is the
working screen and the second is the spare screen. Each time you
select a menu, your picture is saved on that spare screen. The

Fl key restores your picture by copying the spare screen onto
the working screen. The F2 key makes a copy of your working
screen on the spare screen while in draw mode, this is usefull
before trying something difficult, ' or after a few minutes or
hours of hard work.



TOOLS and MENU SUMMARY.

This

chapter describes the functions of H.S.H.'s Final Graphics

Tools and Menus.

1.~

The
type

FILE MENU > LOAD PICTURE

SAVE PICTURE
MERGE PICTURE
SAVE BLOCK
PICTURE DUMP
BLOCK DUMP

FAST EPSON DUMP
FAST MSX DUMP
COMPRESS PICTURE
EXPAND PICTURE

program will use its own extensions for the files. Don't
an extension when 1loading or saving pictures. The

extensions used are:

)

(2]

(3]

£4]

£S]

[6]

JPIT Used by the commands LOAD and SAVE PICTURE. Denotes a

picture that can be loaded from BASIC with the COPY
command.

. COL Used to save the colour file. LOAD, SAVE, COMPRESS and

EXPAND will use this extension for the colour file.

. BLK Denotes a saved Block. SAVE BLOCK.

.FNT Denotes a Font file. The Font and Text editors use
this extension.

.BSH Denotes a Brush file. The Select Brush and Brush
editors use it. .

.CMFP Denotes a compressed picture. Used by the Conmpress
and Expand commands.

SAVING A PICTURE

H.S.H.'s FINAL GRAPHICS has three options for saving your art

work

(1]

(2]

(3]

or picture, all of them can be selected from the File menu.

Use the command Save Picture to save a picture and its
colour settings, as a file that can be loaded from BASIC
with the COPY command.

Use the command Save Block to save just a part of vyour
picture.

Use the command Compress to save a whole picture 1in the
compressed format, this will save from 50% to 80% of disk
space. This 1is a special format only available in this
program,

10



LOADING A PICTURE
There are also three ways to get a saved picture to the screen:

(11 The LOAD PICTURE will load a picture and its colour set-—
tings which has been saved with the SAVE PICTURE command.
You may use these pictures on any of your prograns by using
a program like the following one:

10 SCREEN 7: COLOR 0,0,0: CLS 'set screen 7

20 OPEN "filename.COL"” FOR INFUT AS #1 'read in colours
30 FOR I=0 TO 15

40 INPUT#1, A,B,C

50 COLOR =<(I,A,B,C)

60 NEXT I

70 CLOSE #1

80 COPY "filename.PIT" TO (0,0)>,0 'load picture

S0 GOTO 90

(2] The MERGE BLOCK is used to merge a saved picture or block
with your current picture. The selected file will be loaded
and displayed. Mark the block you want to copy onto vyour
current picture, by clicking and dragging until you enclose
the area. After marking the block you will see your current
picture, move the block where you wanted and click. When
releasing the button you will return to the first picture.
This operation can be repeated as many times as needed.
Click the second button to abort and return to the menu.

This is a very useful tool. You can save drawings with
different objects that can be used on many pictures,. You
can build a whole data base of pictures and merge them when
reguired. For example:

draw a picture including different Christmas objets, like a
present box, a tree, Santa Claus, children playing, etc.
If you want to create some Christmas post cards you may use
some of the objects in them by drawing first the background
and them importing the objects from the file. The same
could be done with animals, birds, clouds, etc..

{3)] The EXPAND PICTURE will load a compressed picture. All the
demo pictures have been saved in a compressed format to
save disk space.
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THE LOAD and SAVE WINDOW:

: LOAD PICTURE v 8Ge~ Pt Ye.

7 -0 ey 13 :‘

E ———————————————————— ; {-— Here you will write the filename.
;—-_B;;;;;;;;? ______ ; {-— Click here to get a new directory.
.——--_-—-~_-—‘_——?;: == Click on this 'N’' to scroll the

files. (N = next)

(== Click over any filename to select it.

You don't need to position the pointer to type a name, just type
it and it will be written in the right place. Use the {BS] key

If you posses an H.S.H. MSX Hard Disk System, vyou can alsc
access this by Simply carying out the same pProcedure as above.

The following Hard Disk Systems are available for the MSX fro=m
H.S.H.:

USING THE DUMP ROUTINES:

H.S.H.'s Final Graphics was designed to be used with MSX and
Epson compatible pPrinters, there are three options for dumping
Screens on a Epson printer and just one for the MSX printers.

(11 PICTURE DUMP: this option will print the whole sScreen on a
Epson compatible printer. This is a black and white dump
with 64 shades.

(2] BLOCK DUMP: The same as above but it will print only the
marked block.

(3) FAST EPSON DUMP: This option prints the whole screen in a
reduced format. It uses a special file EPS-DUMP. BIN. Youw
may use this file on your own program. Use it with
BLOAD”BPS-DUKP.BIN",R.

(4] FAST MSX DUMP: This is the same routine as above, but for
any standard MSX printer. It uses the file MSX-DUMP. BIN

You may also use this file in any other program wits
BLOAD" MSX-DUMP. BIN", R.
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By including these print routines, H.S.H. has made some useful
and powerful ’'tools' available to the MSX User which for a long
time have been the cause of some 'head ache'. You are now able
to use these routines as 'Stand alone programmes' or incorporate
them into your own programes, enabling you to get HARD COPIES of
the appropriate screens quickly and easily.

2.— THE TOOLS MENU > TEXT
BROAD PEN
PENCIL
ERASER
LINES
CONTINUED LINES
TRIANGLE
RAYS
RECTANGLE
FILLED BOX
INVERTED BOX
VERTICAL BARS
HORIZONTAL BARS
BRUSH
DOTED BOX
AIR BRUSH
PAINT/FILL
CIRCLE
FILLED CIRCLE

These are the available tools. The colour used by these tools is
the foreground colour, but some 0f them will use also the back-
ground colour. Both colours can be seen on the pointer, and they
can be selected from the palette menu.

TEXT: Use this tool to write text onto the screen.

BROAD PEN: This tool lets you draw dotted freehand with
any of the 12 shapes (selected 1in the
OPTIONS menu: 'PEN: SHAPE’ ). Use 1t by
dragging the mouse.

PENCIL: Draws a thin line.

ERASER: Erases the features of a drawing along the
pointer path.

LINES: Draws a straight line.

CONTINUED LINES: Draws continued straight lines.

TRIANGLE: Draws a triangle.

RAYS: Draws stright lines with the same starting
point.

RECTANGLE: Draws a box with square corners.

FILLED BOX: Draws a box filled with the foreground
colour.
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INVERTED BOX:

VERTICAL BARS:

HORIZONTAL BARS:

BRUSH:

DOTTED BOX:

AIR BRUSH:

PAINT/FILL:

CIRCLE:

FILLED CIRCLE:

4.- PALETTE MENU >

SELECT and

ADJUST RGB:

Both
you

their
you

palet
point
point
up or
butto

same as above, but it does an XOR logical
operation on the colours. If you want to
create a negative of your picture Jjust
select the white colour and use this tool.

Draws a box filled with wvertical bars. It
uses both colours, the foreground colour and
the background colour.

Draws a box filled with horizontal bars.

Paints in the current pattern. The pattern
can be selected from the OPTIONS menu. The
brushes are include in the file BRUSHES. BSH,
and they can be edited with the brush
editor. You can have as many files of
brushes as you want.

Draws a box filled with dots of the fore-
ground and background colours. Very useful
to create new colours. By using this tool
you can simulate 512 colours on the screen
at the same time.

Sprays paint in the current colours. If no
colour 1is selectes from the options menu,
the foreground colour is used.

Fills an enclosed area with the foreground
colour. The area must be drawn in the back-
ground colour,.

Draws a circle or an ellipse.

Draws a circle filled with the foreground
colour.

SELECT

ADJUST RGB

LOAD

SAVE

RESET

SAVE PREFERENCES
ANIMATE

access the same window. From this window
can select any of the 16 colours or adjust

RGB value to suit you picture. This gives
access to the 512 colours of the MSX2
te. To adjust the RGB of a colour move the
er onto the colour and click. Then move the
er onto one of the slides and drag the mouse
down. To close this window press the right
n of the mouse.
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SAVE:

LOAD:

RESET:

SAVE PREF.:

ANIMATE:

S5.- OPTIONS >

SELECT BRUSH:

PEN SHAPE:

LINE VIDTHS:

MIRROR:

2D GRID:

Saves your current RGB settings on a disk file of
your choice.

LLoads a saves colour files.

Resets the colours to the default Final Graphics
values.

Saves your colour preferences in a COLOR.DAT
file, which will be used when starting +the
program again.

Produces the effect of movement by changing
colours, First select up to 15 colours. Then set
the speed by clicking over the + or - and then

click onto OK to start. Press the right button to
abort the colour animation (keep the button down
until it stops).

SELECT BRUSH
PEN SHAPE
LINE WVIDTHS
MIRROR

2D GRID

3D GRID

SPRAY COLOURS

Click over this command. Give the filename to be
loaded. Move the pointer over the desired brush,
and click. This will be the current brush to be
used with the brush tool. This tool will be
automatically selected when a brish is selected.

Selects the pen shape to be used with the broad
pen.

Selects the line widths to be used with the line
tool.

Selects the symmetry to be used with the pencil
tool.

This 1is a regular pattern of 1lines on your
screen. The first time you access this option you
will turn the grid on, the next, will turn it
off. Vhy and how to use it? The reason of this
grid is to be able to draw difficult pictures on
your screen from photos or paper drawings. First
get a transparent plast and draw a grid on it
(for example 0,5 cm each block). Then get the
picture vyou want to draw on your screen and put
the grid on it. Count how many vertical squares
you need and create the grid on your screen. Use
the pencil to sketch your drawing, remove the
grid and then add the details and colour.

15



3D GRID: Draws a 3D grid to help you draw 3D perspectives
like houses, trees, people, mountains, etc. After
selecting this option click where you want the
origin of your perspective to be. Again just
sketch your drawing with the pencil, then remove
the grid (by accessing the same option) and then
add the details and colour.

SPRAY COLOURS: This option lets vyou select up to 15 colours and
three sizes to be used with the AIR BRUSH tools.
Select the colours by clicking on them and select
the size of the spray.

6.~ SPECIAL > ENLARGE/REDUCE
Z0O0OM
SCROLL
MOVE
COPY/PASTE BLOCK
COPY/PASTE SHAPE
DISTORT VERTICAL
DISTORT HORIZONTAL
ROTATE LEFT
ROTATE RIGHT
FLIFP VERTICAL
FLIP HORIZONTAL
SWAFP COLOURS

Under the name SPECIAL you will find all the block functions.
You may move, copy, distort and flip in all the ways you wish
any part of vyour picture. Try them to create titles from a
simple text (text tool), enlarge it, distort it, etc.

ENLARGE/REDUCE: Mark the block to be enlarged/-
reduced. Move to where you want
the copy and generate a box of the
size you want the copy. The
original picture (block) will be
enlarged or reduced according to
the size of the second box, no
matter how many times.

ZOOM: Allows part of the picture to be
enlarged over the whole screen for
correction, fine drawing or adding
detail. The UNDO at the bottom of
the =zoom window is to wundo the
changes you may have done. To zoom
a part of the screen move the box
to the position where you want to
work, and click. Click the second
button to zoom another part of
your picture.

16



SCROLL: Slides the picture up, down, left
or right. The scroll is
rotational, this means any part of
the picture that moves off the
edges of the screen will appear at
the other edge.

MOVE: Moves a block from one area to
another.

COPY/PASTE: Uses any part of the picture as a
brush. Use it to copy a block, to
create special effects, =" s 1o
create a big brush.

COPY/PASTE SHAPE: Lets you copy or use any part

of the screen as a non rectangular
brush.

DISTORT VERTICAL/HORIZONTAL: Copies a marked block and lets you

distort it by moving the mouse
up/down or left/right.

ROTATE RIGHT/LEFT: Copies and rotates a marked block.
FLIP VERTICAL/HORIZONTAL: Flips a marked block. (Doesn’t copy
the block)

SVAP COLOURS:

v.—= BDITORS >

Swaps the background with the
foreground of the marked block.

FONT EDITOR
TEXT EDITOR
BRUSH EDITOR
3D EDITOR

After selecting any of the editors the editors program will be
loaded, and a new main menu will appear.

FONT EDITOR

FONT EDITOR:

TEXT EDITOR

BRUSH EDITOR 3D EDITOR FINAL-GR.

Clicking over this menu will first ask you for a
filename. Then a window showing the font editor
window will appear. This editor is for creating
special letters for titles, thus it uses only the
upper case letters. It allows you to define 32
characters of a size of 32x16 and in 16 colours.
The characters are the ASCII codes from 65 to 95,
these are the capital letters and the characters
s A7 e e el

To start editing press the character you want to
edit. The character will be enlarged (if it was
defined already) and then uses the mouse to drag
the colours and shape. When all the characters
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are ready click on the SAVE icon to save your
font file to disk. To quit just press the right
button of the mouse.

TEXT EDITOR: This is an editor to create titles,and includes a
few editing functions. First load the font file,
then Jjust type the characters at the pointer
position. The 1icons at the 1left are self
explaining and use them by moving the pointer
onto them and clicking the left button of the
mouse . The SAVE TO DISK option will save the
marked area as a TEXT.BLK file, this is meant as
a momentary file.

Here are some tips of how to produce a title:

(1] Before selecting the editors, clear the
screen from the Final Graphics main program,
selecting the transparent colour.

(2] Load a font file.

[3] ©WVrite the text. Don't worry about how it
looks on the screen.

{4] Copy the text on to your screen, by selecting
COPY TO DRAWVING.

(5] Quit the editor by pressing the right button
of the mouse.

(6] Return to Final Graphics.

(7] Use the enlarge/reduce, distort, Zoom com-
mands and other tools to enhance the title.

(8] Save the title as a block.
[9)] Load your picture.

({10] Merge your title using any of the logical
options. Try different logical operations
and see the results. Normally you will use
the TPSET. See your computers manual for
details about these logical operators.

THE BRUSH EDITOR: Enter the filename. The window is very similar
to the font editor. Move the pointer onto a blank
space o0f the bottom of the screen (to create a
new brush) or onto a brush (to modify it)> and
click the left button. The brush will be enlarged
and now you a ready to edit it. When ready with
all the brushes, just move the pointer onto the
SAVE icon and click it. The brushes will be saved
under the filename you selected.

The brushes are 32x16. If you need bigger brushes
use the COPY/PASTE of the Final Graphics program:

18



THE 3D EDITOR:

FINAL-GR. :

With this editor you may edit figures that are
circular in shape, like balls, bottles, glasses,
wheels, cups, etc. To edit the shape click on the
DRAWV 2D SHAPE icon. Drag and click the mouse to
draw the lines of the shape of your object. Press
the right button when ready and the 3D object
will be drawn. This will be a wire frame object
that vyvou can save to disk (3D-SAVED. BLK) , or
copied to vyour drawing, rotated through any
angle, drawed again, etc, just by using the icons
at the left.

Click on this menu to return to the Final
Graphics main program.

——— KKK ===
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ICON PAINT SC5 and S8C8.

These two programs are, two short but, powerful programs to be
used in the other screen modes, screen 5 and screen 8. The user
interface is completely different from that of Final Graphics.
The user interface is icon orientated. The pictures can be also
saved and loaded as in Final-Gr, ©but they are saved as a binary
file. This means that the pictures can be loaded later just by
typing: BLOAD"filename”, S.

Again, don’'t use extensions when naming files. The programs will
use their own extensions. ICON PAINT SC5 will use '.SC5' and
ICON PAINT SC8 will use '.SC8'. As you may understand SC5 refers
to SCREEN 5 and SC8 to SCREEN 8.

The icons are the same in both programs, and the only difference
occurs in the PALETTE menu.

You access the menus by clicking the right button of the mouse.
The menus appear at the cursor position, and the menus disap-
pear when the pointer leaves the menu area. This makes the
interface very fast and easy to use.

1.- PALETTE MENU.

ICON PAINT SC5: The palette has the 16 colours and the
possibility to adjust their RGB wvalues, to
fully use the 512 MSX2 palette. To select a
colour Jjust click on it,. To adjust the RGB
just click on 'R', 'G or 'B' and the values
and colour will change. The icon at the
bottom is to clear the screen.

ICON PAINT SC8: The palette shows only 64 of the 256 colours
available. The icon with a down arrow shape
is to display the next group of 64 colours.
The other icon is to clear the screen.

The colours are displayed in four groups,
each one containing a different guantity or
level of BLUE. This makes selection of
colours very easy.

2.- THE TOOLS MENU.

The tools menu on both programs are the same. here is a complete
description of all of them.

The 1icons are described from left to right and from top to
bottom.
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PENCIL:

DOTTED PEN:

PENCIL +XY MIRROR:
PENCIL + X MIRROR:
PENCIL + Y MIRROR:
LINE:

CONNECTED LINE:

RAYS:
BOX:

FILLED BOX:

CIRCLE:

FILLED CIRCLE:
.PAINT/FILL:

BRUSH:

AIR BRUSH:

ZOOM:
TEXT:

EXCHANGE COLOURS:
3.-THE BLOCK MENU.
COPY BLOCK:

MOVE BLOCK:

COPY SHAPE:

Draws a thin line.

Draws a dotted line.

Draws a thin line with XY symmetry.
Draws a thin line with X symmetry.

Draws a thin line with Y symmetry.

Drawse a strait line.

Draws a strait line and the end point becomes
the start point of the next line.

Draws strait lines with the same start point.
Draws a box.

Draws a ©box filled with the foreground
colour.

Draws a circle or an ellipse.

Draws a circle or and ellipse filled with the
foreground colour.

Fills an enclosed area (drawn in the back-
ground colour) with the foreground colour.

Paints in the current colour.

Sprays paint in both colours, foreground and
background.

Zoom in on the picture at the point marked.
Writes text on the picture.

Exchange the background colour with the fore-
ground colour on the marked area.

Copies the marked block. Can be used as a
brush.

Move the marked area.

Coples a nonrectangular area. Can be used as
a brush.

DISTORT HORIZONTAL: Copies and distorts the marked block. The

distortion is controlled by the mouse.

DISTORT VERTICAL: Copies and distorts the marked block

ROTATE RIGHT:

vertically.

Copies and rotates the marked block.
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ROTATE LEFT: Copies and rotates the marked block.

FLIP VERTICAL: Flips vertically the marked area.

FLIP HORIZONTAL: Flips horizontally the marked area.

ENLARGE/REDUCE: Copies, enlarges or reduces the marked area
depending on the the size of the second
marked block.

4.- THE FILE MENU.

DISK: Allows LOAD, SAVE and MERGE pictures.

PRINTER: Dumps the screen on a Epson printer.

DIGITISE:Digitise a picture.

END: Stops the program.

Both programs ICON PAINT SC5 and SC8& have the UNDO key, the Fl

kev. ICON PAINT SC5 can work with two screens at the same time.
The screens are swapped with the Fz key.

If you want to dump any picture from these two programs on a MSX

printer, use the following program:

10 SCREEN S5 'or SCREEN 8

20 BLOAD'"filename.SC5",S ‘or filename.SC8

30 BLOAD" MSX-DUMP.BIN",R ' Load and run the MSX dump routine
40 END

If you have doubts or trouble with any part of these progranmns

please drop us a line, we’'ll be very glad to help you:

H.S.H. Computervertrieb GmbH
Romberg Str. 16

D - 4715 Davensberg

Vest Germany

Tel: 02593-6168
Fax: 02593-7234

Programmed Dby:
J. Salas

——— kKX ———
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The programme has been provided in good faith, however, should
H.S.H. Computervertrieb GmbH find updating necessary, by filling
in the coupon below and returning it to H.S.H., we will notify

you of any such updates and offer them to vou at a special
price.

SURNAME

FIRST NAME

ADDRESS

COUNTRY

- ———— - s ——- ————— . S ——

DATE OF PURCHASE:

e e+ e 2t ¢ B ——— 5 — ——

INVOICE NO.

R e b S A AP p———
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